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M-Disk

by Tim Purves

M-Disk uses a portion of your computer’s memory to load,
store and save data as if it were a normal disk drive. The
"phantom" or ram disk is faster and more reliable than a
hardware drive because it has no mechanical parts.

How M-Disk works

M-Disk works by reserving a portion of memory as a
software image of a disk drive. Except for instructions that
address the physical characteristics of a drive, the ram disk
operates just like a normal hardware disk drive and diskette.
No formatting is needed. (In fact, attempting to format the
ram disk may destroy other diskettes! Read the first
warning on page 4.)

This version of M-Disk can reserve up to 800K of memory
(if that much is available) for a ram disk. With the original
version of TOS on disk for the Atari 520-ST, you can use a
ram disk of up to 99K if no GEM Desk accessories are
loaded, 62K if the VT-52 Terminal program and the Control
Panel are loaded. If TOS is resident in ROM, the amount of
available memory is increased.

Make a working copy FIRST

Copy M-Disk to the disks you plan to use it on, then store
the original in a safe place. Use the original only to make
working copies: if a working copy is damaged, you’ll still
have the original to make a replacement.

You can also copy M-Disk directly to the disks that can use
it the most, like your word processor working disk.

M-Disk - Page 1
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How to install M-DISK

You must install M-Disk and choose the size of the ram
disk before executing any program that uses it. That can be
done automatically at boot time or manually any time

before a program uses it. To remove an existing ram disk,
you must reboot the computer.

M-Disk always reserves for the computer at least the
minimum 128 kilobytes of memory TOS demands. The
available memory M-Disk announces already takes account
of this requirement and its own overhead, so you may
specify any disk size up to the announced available
memory. Deleting the files DESK1.ACC and
DESK2.ACC will let you create ram disks 27K larger.

. If you specify less than 2 kilobytes for M-Disk, installation

is cancelled.

For manual installation, begin at the TOS
main menu. Open the disk drive containing M-Disk by
double-clicking on the proper disk icon. The directory will
be displayed.

Double-click on the icon labeled MDISK.PRG. The pro-
gram title screen will appear. M-Disk shows how much
memory is available, then asks for the size of the ram disk.

Type the number of kilobytes of memory you want M-Disk
to use and press RETURN. This number must be larger
than one and less than or equal to the number of kilobytes
M-Disk declared available. If you press only RETURN,
M-Disk will use all the available memory.

To create the ram disk icon you will need for access, go to
the TOS main menu, select a drive icon, then choose Install
Disk Drive from the Options menu. Type the drive name
chosen by M-Disk (Be sure to use a capital letter) and
RAMDISK as the drive identifier. Click on Install.

M-Disk - Page 2




For automatic installation, you must
add an AUTO folder to your boot disk. Boot up as usual,
then select your boot drive and draF down the File menu.
Click on Open, then on New Folder. Type the folder
name AUTO and click on OK. Pick up the MDISK.PRG
icon from its disk directory and drag it to the AUTO folder
to copy. Click on OK on the Copy window if your
preference is set to confirm copies.

Check the AUTO folder to see if MDISK.PRG is present.

. Reboot with the modified boot disk. The M-Disk opening

screen will appear. After M-Disk asks for the size ram disk
to reserve and announces the installation on a particular
drive, the program will copy the files DESKTOP.INF,
DESK1.ACC and DESK2.ACC to the ram disk, then ask
you to press RETURN to exit to the GEM Desktop.

At the TOS main menu, select a drive icon, then choose
Install Disk Drive from the Options menu. Type the drive
name announced by M-Disk (Be sure to use a capital letter)
and RAMDISK as the drive identifier. Click on Install.

Select Save Desktop. This will copy the new Desktop,
including your ram disk, to the ram disk DESKTOP.INF
file. If you want to change your preference settings, now is
the time. Finally, copy everything to your boot disk by
clicking open the ram disk, then dragging the
DESKTOP.INF file to the disk A icon. Click on OK to
approve overwriting the current DESKTOP.INF file.

. Your boot disk will automatically install M-Disk whenever

it boots the computer.
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Warnings

Do not attempt to format the ram disk! It is
formatted automatically when installed. (Remember that
the ram disk acts as a disk drive with diskette already in
place.) If you attempt to format the ram disk, the operating
system may format all mounted disks! This arises from an
oversight in the TOS from Atari.

Be sure to use a capital letter as the drive name
for each ram disk. The computer expects other devices
to be assigned as lower-case letters. .‘,

Error messages

Can’t allocate memory for M-DISK: There’s not enough
memory to create a ram disk and leave 128K for TOS.

There are no more available drive slots: All the block
devices from drive C: to I: are in use.

You have requested more memory than is available: The
size you specified was larger than M-Disk has available.

Size is too small for M-DISK. I am assuming you wish to
abort installation: Specifying a size of less than 2K will
abort installation of M-Disk.

Read.Me file

Updates, if any, are stored in a file on the MICRODEAL disk
called READ.ME. If the file exists, read it by double-
clicking on the READ.ME icon, then choosing Show (on
the screen), Print or Cancel. Make a note of the updates in

this booklet.
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MmiICRODEAL brings you more helpful utilities for your
Atari ST...

SOFT SPOOL
by Timothy Purves

While printing files (from word proccessors, TOS, etc.),
your computer is just dead weight; waiting and waiting for
the printer to finish. With Soft Spool, the wzit is over! Now
your computer can think and print at the same time! This
software spooler sends printed data to the printer between
tasks, freeing the computer for more important jobs, and
saving you hours of computer time!

CALENDAR
By J. Weaver Jr.

This program helps keep you up to date! Record and store
any notes or appointments from the year 1980 to 2099: any
day, any time. You can access Calendar anywhere in GEM
as a desktop accessory. Events like weekly meetings can be
recorded easily, and without repetition. You can even set
special "alarms" to inform you, anytime in GEM, of noted
events as they occur!

MI-TERM
By J. Weaver Jr.

This smart-terminal modem program lets you use ASCII,
DFT, and X-modem protocols to send and receive data.
With Mi-Term you can set communication options to con-
nect to virtually any other computer or terminal system.
Transfer programs, send messages, and even "talk" between
computers. There’s a big world out there. Greet it with
open arms; greet it with Mi-Term!

Please return your registration card. Microdeal will keep you updated with new products and updates
to this program.

Microdeal, 41 Truro Road, St. Austell, Cornwall PL25 5JE. Tel: 0726 68020.
COPYRIGHT: This program is the copyright of Microdeal Limited, St. Austell, Cornwall. No
copying permitted. Sold subject to the condition that this cassette may not be rented or re-sold.

© 1985 MICRODEAL Made in England

This program is produced under licence for the European Markets from Michtron of Michigan
LS







by Timothy Purves

Get your computer and printer to work as a team!

MICRODEAL






How to install SOFT SPOOL

To install SOFT SPOOL, double-click on the icon labeled
SSPOOL.TOS. The screen will clear to be replaced by the
SOFT SPOOL program logo. SOFT SPOOL will show
how much memory is available, then ask you how much
memory you would like to use in the print buffer.

Type the number of kilobytes you want, or press RETURN
to use all available memory. The minimum size you may
specify is 1; SOFT SPOOL shows the maximum.

SOFT SPOOL always reserves for the computer at least
the minimum 128 kilobytes of memory TOS demands. The
available memory SOFT SPOOL announces already takes
account of this requirement, so you may specify any buffer
size up to the announced available memory. Deleting the
files DESK1.ACC and DESK2.ACC will allow larger
SOFT SPOOL buffers to be created.

If you specify a buffer size of 0 (zero), installation of SOFT
SPOOL aborts.

How to use SOFT SPOOL

Once installed, SOFT SPOOL invisibly intercepts BIOS
print calls. You need do nothing special to use it: just make
print requests as normal. Because of limitations in the
original version of TOS, SOFT SPOOL can be deleted
only by re-booting.

Since the original version of TOS does not use the BIOS
routines to I;)rint the screen, screen prints cannot be spooled.
(SOFT SPOOL intercepts TRAP 13 functions 3 and 8.)
When non-BIOS print calls are made, SOFT SPOOL is
ineffective but will not interfere with the print operation.

This version of SOFT SPOOL sends data to the printer at
about 80 characters per second.




SOFT SPOOL

by Timothy Purves.

SOFT SPOOL lets you use your computer while you print.
Without SOFT SPOOL, a computer that’s printing is a
computer that’s not available. With SOFT SpPOOL, you
and your printer can work at the same time.

How SOFT SPOOL works

SOFT SPOOL works by reserving a section of your
computer’s memory as a print buffer. Any data to be
printed is stored in the SOFT SPOOL buffer, then
transferred to the printer as needed without interruptin
other operations of the computer. In effect, SOFT SPOOlg.
tells the computer the printing is finished but continues to
work behind the computer’s back to control the printing
operation. The computer will operate normally while

OFT SPOOL supervises the printing, except that the
usable memory size will be reduced.

This version of SOFT SPOOL can set aside up to 16
megabytes of memory if it is available. With the original
version of TOS loaded from disk, you can set aside a 111-
kilobyte SOFT SPOOL buffer on the ST-512 if no desk
accessories are loaded, 84 kilobytes if the VT-52 Terminal
program and the Control Panel are loaded. If TOS is
resident in ROM (read-only memory), the limits increase.

Make a working copy FIRST

Copy SOFT SPOOL to the disks you plan to use it on,
then store the original in a safe place. Use the original only
to make. working copies: if a working copy is damaged,
you’ll still have the original to make a replacement. If you
add SSPOOL.TOS to your TOS working copy, it will
always be available.




Error messages

Can’t Allocate memory for SPOOLER - There wasn’t
enough memory to create a SOFT SPOOL buffer yet still
leave 128 kilobytes for TOS.

You have requested more memory than is
available - The buffer size you specified was larger than
the limit set by SOFT SPOOL.

Size is too small for a SPOOLER, | am assuming
you wish to abort installation - Specifying 0 (zero) for
the SOFT SPOOL buffer size aborts installation.

Warning SPOOLER Already has a xxk Buffer
Active, Clear Backlog (Y/N) ? - SOFT SPOOL is
already installed with a buffer of xx kilobytes. You may
clear all data waiting in the printer queue by responding Y.
Doing so lets you print new material without waiting for old
material to finish printing, but it also means you will have
to make a new request to print the old material - it is lost if
dropped from the queue.

An Error Occurred De-Allocating Memory - This
error should never occur! If this message appears, the
machine memory has been damaged. Possible causes are
hardware problems or an application program run wild.

Backlog Cleared! - This normal (non-error) response
appears when all queued data has been cleared.

Read.Me file

Updates, if any, are stored in a file on the MICRODEAL disk
called READ.ME. If the file exists, read it by double-
clicking on the READ.ME icon, then choosing Show (on
the screen), Print or Cancel. Make a note of the updates
in this booklet.



Plcase return your registration card. Microdeal will keep you updated with new products and updates
to this program.

Microdeal, 41 Truro Road, St. Austell, Cornwall PL25 5]JE. Tel: 0726 68020.
COPYRIGHT: This program is the copyright of Microdeal Limited, St. Austell, Cornwall. No
copying permitted. Sold subject to the condition that this cassette may not-be rented or re-sold.

© 1985 MICRODEAL Made in England

This program is produced under licence for the European Markets from Michtron of Michigan
USA:




microoeaL helpful utilities for your
ATARI ST ...

M-DISK
By Timothy Purves

Get the power of an extra disk drive without the extra cost!
M-Disk is a new disk drive with some amazing properties:
it’s super-fast, incredibly tough, and costs only as much as a
single piece of software! The key is that M-Disk is not
actually a hardware device; it’s a software utility! M-Disk
lets you reserve some portion of your computer’s memory,
which is formated to resemble the information on a standard
disk drive. M-Disk then makes the operating system recog-
nize it as a hardware device, giving you all the advantages
of an extra disk drive: extra speed, extra power--everything
except the extra cost!

CALENDAR
By J. Weaver Jr.

This program helps keep you up to date! Record and store
any notes or appointments from the year 1980 to 2099: any
day, any time. You can access Calendar anywhere in GEM
as a desktop accessory. Events like weekly meetings can be
recorded easily, and without repetition. You can even set
special "alarms” to inform you, anytime in GEM, of noted
events as they occur!

MI-TERM
By J. Weaver Jr.

This smart-terminal modem program lets you use ASCII,
DFT, and X-modem protocols to send and receive data.
With Mi-Term you can set communication options to con-
nect to virtually any other computer or terminal system.
Transfer programs, send messages, and even "talk" between
computers. There’s a big world out there. Greet it with
open arms; greet it with Mi-Term!









